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Preface

Have you ever spent hours going through long software manuals and endless forums trying
to work out how to analyze structural MRI scans? We used to do that too, so over time we

have documented how to use a wide variety of software packages so we could conduct the
analyses we wanted to carry out. We have also received training in some of these packages
which has enhanced our competence in these programs.

We don't claim to know how to use every module of every program, but we know how to
use them to conduct most of the analyses that you are likely to want to run. We have
utilized what we’ve learnt by publishing dozens of peer-reviewed papers but also passing on
this skill set to many students and research groups around the world.
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CHAPTER 1

Introduction

Whilst there are many packages available, we have found that those we describe in this
handbook have collectively been sufficient to analyze structural MRI scans. However, we
encourage you to seek alternative packages if you do not find these ones adequate to
accomplish your tasks.

In this handbook, we provide step-by-step instructions in how to use your data to achieve
the output you require. The focus of this handbook is T1-weighted and Diffusion data
acquisition and analysis.

Topics covered in this handbook

e  Minimum computer specifications

e Installation of these packages

e Tl-weighted and Diffusion Tensor Imaging
e Other structural sequences to consider

e Whatis T1-weighted useful for?

e What is DTl useful for?

e Issues to consider before acquisition

e Software

e Pipelines/scripts to save you time

Minimum computer specifications

Windows (pc), Linux/Unix, Macintosh/Apple

The bare minimum specifications are Core2Duo CPU with 4GB RAM, but, of course, it’s best
to have the fastest and most amount of RAM you can access. Same goes for the hard drive
capacity: at least 250GB but the bigger the better!

Although you could have a pc running Windows and Linux through a virtual machine (VM),
this is not an ideal setup as VMs are notoriously slow. By contrast, a dual-booting pc would
be far preferable (this is, Windows and Linux on the same pc with a simple boot menu when
you turn on the pc). If you have a Mac/Apple, then the best setup is to run the Mac OS
natively and then install dual-boot software such as Bootcamp or Parallels and then install
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Windows onto that. Note the Mac/Apple is essentially running on Linux, so you simply open
a terminal and you immediately have a type of Linux running natively — very handy.

Of course, if you have access to a supercomputer/cluster via the university then you could
run all of your analyses on it, but note that those huge mainframes sometimes have
problems and need to shut down to reboot which will interfere with your batched analyses.

Note that not all MRI analysis packages are multi-threaded i.e. they do not use more than
one CPU at a time, whereas those that are multithreaded can utilise as many CPUs as you
have available on the computer. Again, very handy.
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Installation of these packages

Most of these packages are simple executable (.exe) files than run natively on Windows.
However, some run only on Linux/Mac (e.g. FSL, Freesurfer) so need to be
installed/compiled with the correct paths and calling the correct files; sometimes you will
need to install updates via apt-get. Some (e.g. Freesurfer) run in separate shells (e.g. tcsh or
csh). If you are a Linux/Mac user, you may find it convenient to run the Windows packages
via VMs, or use Windows emulators such as wine.

T1-weighted and Diffusion Tensor Imaging (DTI)

Without going into the physics of it, T1-weighted is essentially the sort of scan you acquire if
you want data with good grey/white matter contrast. The word ‘contrast’ is this context
means the clarity of the grey/white matter borders. This is very important when segmenting
regions of interest (ROIs) as they rely on clear grey/white matter borders. However, the
clarity of these borders is also important in the clinical context as a lack of contrast between
grey/white matter can sometimes indicate poor structural integrity as sometimes seen, for
example, after traumatic brain injury (TBI). A type of MRI sequence that investigates this
more thoroughly is referred to as MTR (magnetisation transfer ratio), but that’s beyond the
scope of this handbook. Note as well that MP2RAGE (T1-weighted with multiple Tls) is not
suitable for most of the software we go through in this Handbook.

Diffusion tensor imaging (DTI) was released in 1994 by Basser and colleagues but not utilised
widely until processing power dramatically increased in the early 2000’s (see our article
reviewing this, Maller et al., 2010). Filler (2009) provides a comprehensive description of its
origins. It is based upon DWI (diffusion weighted imaging) but instead of 2-dimensional data,
DTI acquires 3-dimensional data (or 4-dimensional, depending on how you look at it).
Essentially, DTl produces data that is based upon Brownian movement i.e. the movement of
water between microscopic white matter fibres based on heat. Water will move in a straight
line that is directly parallel to the direction of the white matter when the white matter is
‘healthy’, but the water will move in different directions when the white matter’s integrity is
compromised. As an analogy, think of a bowl| of spaghetti... Another useful analogy is a hose
with water flowing through it: when the hose is new and has no leaks the water will move
parallel to the hose, that is, in an anisotropic direction. Isotropic means the water is moving
equally in all directions, hence, anisotropic means in one single direction. When a white
matter bundle is damaged, it may be compressed or stretched, leading to leaking in that
white matter bundle — this will cause the water flowing within it to leak out the side or its
flow obstructed, leading to the water flow not being parallel anymore to the shape of the
hose i.e. the white matter bundle. When the water flows parallel to the hose in one
direction, the ‘fractional anisotropy’ (FA) has a value of 1; when the hose is leaking and the
water flows in all directions equally (e.g. up, down, out the sides), the FA is closer to 0.

10
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The basic physics of NMR is nicely demonstrated here:
http://www.youtube.com/watch?v=10rPCNVSA40

Other structural sequences to consider

T2-weighted, T2-FLAIR, susceptibility-weighted imaging (SWI), arterial spin labelling (ASL)
T2-weighted is a scan acquired when you want to look at possible pathology, for
example, white matter hyperintensities (WMHs), strokes, tumours, cysts, etc. In normal
ageing, WMHs first appear lining the inner border of the lateral ventricles, referred to as
periventricular leukomalacia (PVL), which often begins after the age of 40. Large WMHs
within cortical or subcortical matter are often representative of pathology, although
WMH ‘dots’ can be as well (sometimes referred to as ‘punctate’). For example, these can
be representative of whit e matter disease sometimes related to late-onset major
depression. The rule-of-thumb is that one WMH per decade is within acceptable limits.
T2-FLAIR is like a T2-weighted scan but the colour of the cerebrospinal fluid (CSF) is
inverted. That is, instead of CSF appearing white, it is black on a FLAIR scan. Hence, FLAIR
stands for FLuid Attenuated Inversion Recovery. SWI focusses on the susceptibility of
iron and myelination, hence, it is “susceptible” to alterations in iron and myelination.
ASL is a sequence used to assess absolute measures of blood flow, rather than relative
blood flow such as in dynamic contrast enhanced MRI (DCE-MRI). However, ASL is
associated with quite high SAR (specific absorption rate), so sequences cannot be too
long.

What is T1-weighted useful for?

T1-weighted data has a variety of uses, but in the research context, it is used mostly for
investigating grey matter (GM), white matter (WM), CSF, and atrophy.

Volumetrics; GM+WM+CSF=intracranial volume (ICV). Total brain volume (TBV)/ICV =
opposite of CSF/ICV. That is, TBV/ICV is a measure of how much of the cranial vault
contains brain matter, whereas the opposite (CSF/ICV) is a measure of how much of the
cranial vault is not brain matter; hence, CSF/ICV is sometimes referred to as a measure
of atrophy. Note that some programs (e.g. Freesurfer) yield data of TBV and ICV but the
TBV does not include blood vessels, choroid plexus, non-brain matter constituents,
hence, TBV/ICV in those programs will be smaller than programs that assume everything
within the cranial vault is either brain matter or CSF (e.g. FSL's FAST module, or SPM’s
segment routine).

Thickness. Cortical thickness is representative of how thick the cortical grey matter is.
Essentially, volume = thickness x area.

11
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e Curvature/shape analysis can also be accomplished with T1-weighted data, but its
meaning is less straight forward.

What is DTI useful for?

e WM Structural integrity and directionality

e FA, L1(AL1),L2(A2), L3 (A3), MD, RD. Figure 1 illustrates what the eigenvalues (A)
represent (from Maller et al.,2010).

e Tractography of WM bundles

A
T L IHH
ol | |1 )1
M !|'!i| ||||||
i | l i
!l'!i! | !||:
I||.I I !l'li

e

A2, A3

e Connectivity
e Fibre density

A —

Figure 1. lllustration of principles involved in diffusion tensor imaging. (A) Microtubules of
an axon encased in myelin sheath. (B) Eigenvectors represent main axes directions. Water
diffusion is restricted along the longitudinal axis (A1) and/or perpendicular to the
longitudinal axis of the axons (radial diffusion, eigenvalues A2, A3) due to axonal
microstructure.

12
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Issues to consider before acquisition

e Scanner type (brand, Tesla, gradients, acquisition pulse sequences installed onto the
console)

e SPGR (spoiled gradient, used with GE scanners), MPRAGE (Magnetization Prepared
Rapid Acquisition GRE (3D Inversion Recovery), MP2RAGE (MPRAGE with multiple
echoes; MPRAGE and MP2RAGE are used with Siemens and Philips scanners)

e DTI, RESOLVE (used for high-resolution g-ball scanning that takes into account crossing
fibres)

e Silenz (GE) and PETRA (Siemens) —these are T1-weighted sequences that are less than
10db above ambient noise level

e Fast scanning/GRAPPA, SENSE, SMASH, PILS etc. These usually are parallel imaging
methods to reduce scanning times although they can also reduce SNR. MRl is always
about give-and-take in terms of SNR

e Fat suppression and chemical shift

e NEX/number of averages — the more averages, the higher the SNR

e Number of channels (receive coils i.e. antennae) — the more channels the better the
resolution but also sometimes lower SNR

e Resolution, repetition time (TR), echo time (TE), slice thickness, signal-to-noise ratio
(SNR) — you can alter TE, for example, but it must not change between subjects, slice
thickness should be less than 1.5mm for T1-weighted and no more than 3mm for DTI

e DTl number of directions: more directions will yield more accurate tractography (but not
necessarily more accurate FA estimation), and more b-zero volumes (T2-weighted scans)
will yield better eddy current and movement correction especially when they are
interleaved

e Anterior commissure-posterior commissure (AC-PC) alignment — important because if
you normalize scans to a template then this will make the analyses more accurate with
higher SNR as the scans will not have to be reorientated to match the template. AC-PC
alignment in the scanner is also important because then you can more accurately
compare data across scans

e Length of scanning period and each sequence — some people will not be able to remain
very still for long periods of time, plus longer scans distribute more SAR

e Volume of scanner/patient comfort/movement — wide bore scanners are preferable for
patient comfort and the ability to put more equipment into the scanner; patient
movement will reduce the quality of the scans

e Knowing for sure which is right and which is left — sometimes software can flip the MRI
scan, so it is useful to use fiducials (markers) that show on the scan so that you can
always be sure which side is left and which side is right. For example, you can tape a
vitamin E pill to the forehead above the right of the subject’s eyebrow before they are
scanned so that the right-side of the scan (head) can always been confirmed.

13
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Software covered in this handbook

e MRIcro (visualization, preprocessing, manual segmentation, lesion overlay analysis;
http://www.mccauslandcenter.sc.edu/mricro/ )

e MRIcron and dcm2nii (format conversion;
http://www.mccauslandcenter.sc.edu/mricro/ )

e MRIreg (http://www.mccauslandcenter.sc.edu/mricro/ )

e BEAM (http://www.clinicalresearcher.org/software.htm )

e MRIconvert (slice conversion http://Icni.uoregon.edu/~jolinda/MRIConvert/ )

e ITK-SNAP (T1-weighted visualization http://www.itksnap.org/pmwiki/pmwiki.php )

e Not free: Analyze® (http://www.analyzedirect.com/ ). Analyze® is the gold standard in

manual segmentation software. There is a large variety of freeware that can be used to
accomplish a similar task, but Analyze® is established as the most comprehensive and
user-friendly package for manual ROl segmentation. It has a number of modules other
than the ROl module, but these are beyond the scope of this handbook.

e Freesurfer (T1-weighted automated segmentation) and QDEC (Freesurfer GUI for
analysis http://freesurfer.net/ )

e SPIN (slice conversion and SWI editing http://www.mrimaging.com/category.103.html )

e DICOMsort (multi-platform, Linux, Mac, Windows, for sorting DICOM images by any of
the values in the DICOM header. http://www.dicomsort.com )

e FSL (http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/ ): brain extraction tool (BET), fully automated
segmentation tool (FAST), tract based spatial statistics (TBSS)

e DTlstudio (deterministic tractography https://www.dtistudio.org )

e MaedINRIA (deterministic tractography http://www-
sop.inria.fr/asclepios/software/MedINRIA/ )

e MRtrix (deterministic and probabilistic tractography http://www.brain.org.au/software/ )
e SPM (for normalization and GM/WM/CSF segmentation
http://www.fil.ion.ucl.ac.uk/spm/ )

Pipelines/scripts will save you time

Once you learn how to use a program, particularly those installed in Linux/Unix/Mac, it will
save you substantial time (and effort) by writing scripts to conduct multiple-step analyses
for multiple scans. You just need to be confident in your scripting! An extreme example of
this is referred to as a “pipeline”. A good example of utilising both T1-weighted data and DTI
data in one ‘program’ is referred to as the “Connectome pipeline” and another is TRACULA
(TRActs Constrained by UnderLying Anatomy;
http://surfer.nmr.mgh.harvard.edu/fswiki/Tracula ), although they may rely on you first

processing the T1-weighted data through Freesurfer and then inputting the output of that
process along with the DTl dataset into the pipeline.

14
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WM bundles: getting to know white matter anatomy

A widely used reference for this is the White Matter Atlas by Mori et al. (2005), but there
are many other white matter atlases/articles well worth considering as well, including,
Wycoco et al. (2013). We encourage you to search on PubMed using keywords such as
“white matter atlas” (http://www.ncbi.nlm.nih.gov/pubmed/?term=white+matter+atlas ).

At the end of this handbook we have included some general advice on where to place initial
seed points for a variety of major WM bundles.

Organisation of this handbook

Chapter 1 presents T1-weighted and DTl analysis, and Chapter 2 presents tractography.

Index of software and instructions

How to convert individual dicoms (slices) into an analyze volume (.hdr + .img): MRIcro
Steps to convert dicoms to Analyze format (.img + .hdr) with decm2nii

MRIconvert

SPIN to convert a directory of DICOMS containing different sequences (series)
DICOMsort (a multi-platform alternative to SPIN) to convert a directory of DICOMS
containing different sequences (series) and anonymise data MRIconvert

Preparing a T1-weighted scan for MiniBIRD

7. Using the Ascension® MiniBIRD (Flock of Birds) for stereotaxic coregistration of MRI-to-

ek wnN e

o

head-and-brain

8. How to locate the DLPFC (F3 or F4) without an MRI brain scan Inter-rater reliability

9. Example of tracing an ROl in MRIcro. In this case, the caudate.

10. Manual tracing of a Region Of Interest (ROI) in Analyze®

11. Steps for 3D rendering in ITK-SNAP of ROI (object maps) traced in Analyze DICOMsort (a
multi-platform alternative to SPIN) to convert a directory of DICOMS containing different
sequences (series) and anonymise data

12. Inter-rater reliability

13. Freesurfer

14. Protocol to process SWI images from magnitude and phase data

15. FSL

16. Tract-Based Spatial Statistics (TBSS)

17. DTlstudio: How to measure FA (and other statistics) of white matter tracts

18. MedINRIA

19. MRtrix

20. Some useful Linux commands

21. References

22. Collection of our published articles that have used the software described in this
handbook

23. Imaging guide for tractography of major white matter fibre bundles
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. How to convert individual dicoms (slices) into an analyze volume (.hdr + .img): MRlcro

A o

10.
11.
12.

13.
14.
15.
16.

17.

18.
19.
20.
21.
22.
23.

Open MRIcro (Rorden and Brett, 2000)

“Import” = conversion wizard (bottom option)

“OK” (conversion options)

“OK” (flip)

A box then appears: select the very first dicom (i.e. the one with the smallest number at
the end of its filename: this should be the first [top] file)

“OK” (call is ‘n’, the default name)

At this stage, all dicoms will now be converted to Analyze format. So now we need to
reslice (slice-and-dice) and have the scan in the correct orientation. To do this:

Open the Analyze file (Open, then select the file)

“Etc” - convert anisotropic to isotropic

“OK”

Open the new isotropic file

Reslice it to 1mm cubed. To do this, look at the top left of the screen and note the length
of the x and y dimensions (e.g. 0.94mm) and enter that box into the reslicing box:

“etc” > “rescale” and enter that number (e.g. 0.94)

“OK”

Open the newly sliced Analyze file

Now we need the scan in the correct orientation; that , bottom left should be axial, top
left should be coronal and top right should be sagittal (nose pointing to the right of the
screen). To do this:

Which orientation is currently displayed when you select Axial (horizontal)? E.g. if
sagittal appears with nose to the right, then do the following:

File > Save As - change ‘axial’ to ‘sagittal right’, then select “Save Intel”

“OK”

Note: need to close MRIcro at this stage, and then reopen it

If you need to normalize, then you will need to do the following

Reorientate the scan parallel to the AC-PC, and

Set the AC as 0,0,0 in the “Origin” column (as in Figure 2)
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File Edit Import Header View ROl (

Header Information-  ImgSz 0.13Mb
Dimension Size{mm) _Origin{vxl)

@ ¥ 2o Spw

—Y|256 +|1.00 -+ |0.00

| =w =

data  16btint | Wie-endian: Intel |

et [0 =] Volumes [1 =
3cale][1.000001 =] Intercept [0.000001 =]

slice Viewer :
E) VY L
} =
Q*]umm =I(Ploooos =

[ Yoke Black &Whie| Square| %2 |

B R R =

WG| L o |
8| Q& (A 4

Figure 2. MRlIcro interface. Red arrow indicates the column where you reset the AC to be
0,0,0

23133133

24. Save As = Save Intel
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2. Steps to convert dicoms to Analyze format (.img + .hdr) with dcm2nii

Install MRIcron (http://www.mccauslandcenter.sc.edu/mricro/mricron/install.html ,

“download the zipped archive”; Rorden et al., 2007)

Navigate to the following directory: C:\Program Files (x86)\MRIcroN
Right-click on the following file: dcm2niigui.exe

Select “Create shortcut”. There will now be a link on the Desktop to this file
Close that directory

Double-click dcm2nii on the Desktop

Click on the “output format” and change it to the first option (Figure 3), “SPM2 (Analyze

hdr/img)”

-

2 Drag and Drop DICOM to NIFTI converter =RREN X

File Edit Help
Output mec"li|;SPM2[3D Anlize hdr/ima) P w

Chrig Rorden's demnii - 7 July 20012
reading preferences file C:h\JzergmallerdppD ata'\Roaming.demZniigul.ini

Figure 3. The DICOM to NIfTI GUI

Navigate to the directory where the dicoms are

Drag the folder of dicoms into the DICOM to NifTl converter window

In a few second the dicoms will be converted to Analyze format and reorientated (if
required)

18


http://www.mccauslandcenter.sc.edu/mricro/mricron/install.html

Handbook of Structural Brain MRI Analysis. April 2015

3. MRIconvert

MRIconvert is an easy-to-use medical image file conversion utility that converts DICOM files
to NIfTI 1.1, FSL NIfTI, Analyze 7.5, SPM99/Analyze, BrainVoyager, and Metalmage volume

formats. MRIConvert 2.0 is also good for .nii output, Analyze 7.5 output, and automatic

generation of diffusion gradient files for Siemens Syngo scanners, Philips, and some GE

scanners. It can be installed onto Windows, Mac, or Linux operating systems.

4. SPIN to convert a directory of DICOMS containing different sequences (series)

1. Open SPIN
File = Sort DICOM and convert

3. A new window opens (Figure 22). Click on the Browse button and navigate to your folder

that contains all of the DICOMS

4. Click “OK”. Within a few seconds all of the DICOMS will have been sorted into their

respective directories, and the names of the directories will be based upon the name of

the sequence (series).

-

Sort Dicom files

Input the DICOM Directany

[v Sort Children Directories under it:

Sort Criterion
" Sart by Seres Mumber and Image Nurmber
" Sort by TE
" Sort by Flip Angle
" Sort by Protocal Mame

{* Sort by Seguence Descrption for EACH SERIES

Ok |

Directory Mames: v Usze Default ¥alues (Mo User Input)
Saving Files: [ Save IM4 files
Delete Empty Direcatry: v Delete

Cancel

Figure 4. Sorting Dicom files using SPIN.
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5. DICOMsort to convert a directory of DICOMS containing different sequences (series)

1. Open DICOMsort software (Figure 23)
2. Click the “Browse” button and navigate to your DICOM folder
3. The values contained in the DICOM header should populate the “DICOM properties” field.

® 00 DicomSort

/Users_/YourDICOMdata[DICOM§ Browse

DICOM Properties Properties to Use

: >> - o
AccessionNumber SeriesDescription

AcquisitionDate
AcquisitionMatrix
AcquisitionNumber Up
AcquisitionTime

AngioFlag Down
BitsAllocated

BitsStored

Columns

ContentDate

ContentTime

DeviceSerialNumber

EchoNumbers

EchoTime

EchoTrainLength

FlipAngle

FrameOfReferenceUID
HiahRit Anonymize Data

<<

Q Sort Images
Ready...

Figure 5. DICOMsort user interface.

4. Choose the values that you wish to sort by moving them from the “DICOM Properties”
field to the “Properties to use” field (Figure 24). The series description is there by default.
Note: If you choose multiple values to sort, the one at the top of the “Properties to Use”
field will be the top-level folder followed by the lower items in subfolders. See figure below
for an example of the folder structure that results from the values chosen
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Properties to Use

PatientName
AcquisitionDate
SeriesDescription L

¥ @m PatientName

v 20120920

... Series0020_relCBF

. Series0019_Perfusion_Weighted

. Series0018_MoCoSeries

. Series0017_ep2d_tra_pasl_p2

. Series0016_gre_field_mapping

. Series0015_gre_field_mapping

. Series0014_MoCoSeries

. Series0013_ep2d_pace_moco_p2_Resting_berkly
. Series0012_gre_field_mapping-diff

. Series0011_gre_field_mapping-diff

. Series0010_DIFFUSION_MGH60_ColorFA
. Series0009_DIFFUSION_MGCH60_FA

. SeriesO008_DIFFUSION_MGH60_EXP

... Series0007_DIFFUSION_MGH60_LOWB
. Series0006_DIFFUSION_MGH60_TRACEW
.| Series0005_DIFFUSION_MGH60_ADC

. Series0004_DIFFUSION_MGH60

.| Series0003_t2_spc_sag_p2_iso_1.0

. Series0002_t1_mpr_ns_sag_p2_lmm_iso
! Series0001_localizer

VVVVVVV"V'V'V'VV'VV[

Figure 6. DICOM properties in DICOMsort.

5. Before sorting the images click on “File”, then “Preferences”, then “Filename Format”
and check the “Keep Original Filename”. (This ensures that other programs, such as
Freesurfer, don’t have difficulty reading the files).

6. If you wish to anonymize the data then check the “Anonymize Data” button. Then “File”,
then “Preferences”, then click the “Anonymizing Fields” button and choose the values that
you wish to anonymize.

7. Click “Sort Images”.
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6. Preparing a T1-weighted scan for MiniBIRD

Convert slice-by-slice into a volume (i.e. scan.img and scan.hdr)

‘Import’ = ‘Conversion wizard’. ‘OK’. Select the very first slice (dicom) and then give the
scan a new name. The dicoms in the directory will be converted into 2 new files: an
Analyze format image (xxx.img) and a matching header file (xxx.hdr)

Locate the new converted scan (‘File’ -> ‘Open Image’). Select the scan’s .img or .hdr
and then Open

Reorientate: ‘File’ - ‘Save As’... Then select ‘Format’ > ‘Sagittal Left’, then ‘Save [Intel]’;
give it a new name, and Save it. Exit MRIcro, wait a few seconds, then open it up again,
and load this most recent scan (that has had ‘Sagittal Left’ applied to it)

‘File’ = ‘Save As’... Then select ‘Format’ = ‘Axial Down’, then ‘Save [Intel]’; give it a new
name, and save it. Exit MRIcro, wait a few seconds, then open it up again, and load this
most recent scan (that has had ‘Sagittal Left’ and ‘Axial Down’ applied to it)

Convert from non-isotropic (anisotropic) to isotropic: ‘Etc’ - ‘Convert anisotropic
image to isotropic’, give it a new name and ‘Save’

Reslice voxels to 1mm? : ‘Etc’ > ‘Rescale’. Enter the voxel dimension (see the ‘Size(mm)’
box) and make sure the ‘Output Size (mm)’ reads 1.00 x 1.00 1.00.

Clip high and low: ‘File’ - ‘Save As’, now increase the values of the ‘Clip high’ and Clip
low’ values until the red lines above and below the T1 scan (it should be displayed from
sagittal by default) are slightly above the skull and just below the bottom of the
cerebellum. Then select ‘Save [Intel]’, give the scan a new name, and Save. You should
now have a saved scan that has 1mm3 isotropic voxels and clipped to only include the
brain stem until slightly above the skull

Extract the brain (include CSF beneath the inner table) — the so-called “BET” process
(Brain Extraction Tool): ‘Etc’ = ‘Skull strip image using BET’, then ‘Go’, then give the
scan a new name, and Save. A smaller black box will appear as iterations occur on the
scan — this should take around 10 to 20 seconds to complete, and then the skull stripped
scan will appear in the MRIcro window from 3 orientations. If only brain and no skull is
present then BET worked well; if not, you need to reClip the scan (Step 5; so that less
skull is present) and then try BET again

Then: Normalize the scan using SPM

1.

Open SPM97

Using a browser (e.g. My Computer), browse to the location of the scan to be
normalized (i.e. the scan above that still has the skull) and have that screen open on the
right-side of the screen

In SPM97, ‘File’ = ‘New’ = Normalization

The next screen (‘New spatial normalization’) presents default values of 1 subject and
‘New document’. Just select ‘OK’
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Click on the + sign next to Subject 1, and ‘Template’, ‘Image to estimate parameters’ and
‘Images to normalize appear’. Click on the + sign next to ‘Template’, and another layer
will appear that states something like ‘C:\SPM96\Templates\PET.hdr’ — you need to
change the word PET with T1 — do this by clicking on that line of text until it turns dark
blue, and then replace PET with T1

Click on the scan.hdr from the My Computer and drag it over the ‘Image to estimate
parameters’, and then again click the scan from the My Computer and drag it over the
‘Images to normalize

‘Calculate’ - ‘Settings’

Click on the tab that states ‘Parameter estimation’, and change ‘Number of nonlinear
iterations’ to none, and ‘Number of basis functions’ to none.

Click on the tab that states ‘Reslicing, and change “Voxel size’ from222to111, and
‘Bounding box’ from MNI to ‘Template’

‘oK’

‘Calculate’ > ‘Start’

After around 10 to 20 seconds the scan will be normalized, but it has to be converted to
another format so that you can open it in MRlcro

Close SPM97 (you don’t need to save changes), open My Computer and locate the
normalized scan: it will begin with an ‘n’ by default. Double-click on the scan and it will
open in MRlcro. Once it is open, save it as a new name (‘File’ = Save As’, ‘Save [Intel]’),
and it will be saved in the Analyze format that can be opened in MRlcro

Or, if you have Matlab, use a newer version of SPM (e.g. SPM8) and utilise its normalization

feature.
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7. Using the Ascension® MiniBIRD (Flock of Birds) for stereotaxic coregistration of MRI-to-
head-and-brain

You will need to find at least 5 anatomic landmarks.

1. Start MRIcro, and make sure the 'Yoke' and 'XBars' controls are checked [outlined in
purple on the picture to the right]. It is generally easiest to find landmarks in the
'projection’ view that shows the Axial, Sagittal and Coronal views simultaneously
[click on the 3D-cube button outlined in blue in Figure 4; Note that different
versions of MRIcro will have different button arrangements]

—5lice Viewer
A= R = =

o

Figure 7. GUI for MRIcro for MRIreg.

3. Load the MRI scan and find your landmarks (regions that you can identify on both
the MRI scan as well as the individual's head [e.g. bones, nose, ears, etc]). If there
are any anatomical regions of the brain you wish to locate (e.g. the motor hand
area), you will also want to work out these coordinates. For all the landmarks, you
will want to know where they appear in the X,Y and Z coordinates (outlined in
green)

4. Start the MRIreg software

5. There are a few bugs in the software, so make sure to do the following:

i) Select: Tracker (one of the pull-down menus), then “Fastrak”, then change it back to
MiniBIRD (i.e. again, select “Tracker” then select “Flock of Birds/Minibird”)

ii) A message will then appear on the screen. At this stage, turn the MiniBIRD switch (on the
front of the unit) to 'STBY', then count 5 seconds in your head, and then switch it back to
‘FLY’. If your Bird is connected correctly, the XYZ position of the bird sensor should appear
(after a few seconds) at the bottom-right of the MRIreg window (e.g. 'FOB -742 139 892");
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this value should change when the Bird sensor is moved. If this does not work, try adjusting
the serial-port speed (the 'FOB' menu allows you to choose a speed between 9600 and
57600 baud, as well as letting you select either a miniBIRD or Fastrak system).

5. You are now ready to add in coordinates to MRIreg. At this point, MRIcro should
be displaying the MRI scan, and MRIreg should be displaying the position of the bird sensor
(at the bottom right of the window) and the MRI scan coordinates (at the bottom left)

Step 1: Calibration

1. With MRIcro, click on the projection view to select an anatomical position. (You
want to select the location where the sensor will be, e.g. instead of the tip of the
nose, select a few millimetres anterior to the tip).

2. Move the magnet sensor to the location displayed in MRIcro (Figure 5).

3. Press the MRIreg '+' button (or press F1). A new spreadsheet row appears in
MRIreg, showing the MRI position (left) and the corresponding magnet position
(right).

4. Repeat steps 1-3 until you have entered all of your anatomical landmarks. You must
enter at least 5 positions, more positions give better accuracy during magnet
tracking. Pick well-separated points (e.g. select regions on the face, the ears, the
back of the head and the top of the head; instead of only points on the face).

Figure 8. MRIreg and MRIcro on one screen.
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Step 2. Magnet Tracking

1. Once you have entered all of your anatomical landmarks in step one, we want to
check the accuracy of the registration process. To do this: select “Mode” (one of the
pull-down menus), and select “Track”. Now when the MiniBIRD magnetic wand
moves, the red cross-bars in MRIcro should move as well

Example: If you wanted to locate the left DLPFC the Talairach co-ordinates are -45,45,35
(or 45,45,35 for the right), which is on the border of the anterior and middle thirds of the
middle frontal gyrus.
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8. How to locate the DLPFC (F3 or F4) without an MRI brain scan

Option A. International 10-20 system

Modified Combinatorial Nomenclature (MCN). This MCN system uses 1, 3, 5, 7, 9 for the left
hemisphere which represents 10%, 20%, 30%, 40%, 50% of the inion-to-nasion distance
respectively (Figure 6).

" Preaurical
poirt

........
(7P @ Q"

Figure 9. The international 10-20 system seen from (A) left and (B) above the head. A=Ear
lobe, C=central, Pg=nasopharyngeal, P=parietal, F=frontal, Fp=frontal polar, O=occipital. (C)
Location and nomenclature of the intermediate 10% electrodes, as standardized by the
American Electroencephalographic Society. (Redrawn from Lagerlund, 1993).
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Option B. “Beam” software (Beam et al., 2009).

1. Measure distance from Tragus to Tragus: make sure it passes through the vertex
(AKA CZ in the 10-20 system). Enter this distance into the software

2. Measure distance from nasion to inion: make sure it passes through the vertex.
Enter this distance into the software

3. Measure head circumference (above the brow-line); this should measure the largest
diameter. Enter this distance into the software

4. Click the “Calculate” button and 2 measurements will appear: “Distance along
circumference from midline (X)” and “Distance from Vertex in CM (Y)”. Use your tape
measure and mark the Xcm distance starting from the midline at the brow-line and
mark the spot with a texta, then measure the Ycm distance from the vertex: it should
end up at the same spot as X

Figure 10 illustrates an example of locating the left DLPFC.

#® Beam F3 Shortcut =

File Edit

Enter Distance (Tragus to Tragus) in CM: 37
Enter Distance (Nasion to Inion) in CM: |36

Enter Head Circumference in CM: |55

Quit ] [ Calculate

Distance along
cricumference from
midline (X):

6.34 cm

Distance from Vertex
in CM (Y):

9.61cm

Figure 10. Beam software interface to locate the left DLPFC.
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9. Example of tracing an ROl in MRIcro. In this case, the caudate.

The brain MRI scan that you will use in this example (called “ch2”) is the ‘smoothed’ MNI
(Montreal Neurological Institute) template (the 27 averages of a ‘normal’ adult brain). This
is included in the MRIcro package. This scan is also included with only the brain (i.e. it has
undergone the Brain Extraction Tool (BET) process), hence, no skull appears on it (called
“ch2bet”). This scan will be used for task (1) so as to allow for more visually representative
3D renderings.

Task 1: Estimate the volume of the left caudate by manually tracing it using MRIcro

Load T1-weighted volume (File > Open File = ch2bet.hdr)

Display axial (transverse) sections (1° icon on the left in the “Slice Viewer” toolbar)
Select the “Pen for drawing object outline” icon (2" icon from the left in the lower row
in the Region of Interest toolbar)

4. Move to slice 97 and begin outlining the superior portion of the caudate. That is, outline

this ROI with the left mouse button and then right click inside the outline to flood-fill it.
If the entire screen is flood-filled, then the outline has not been closed (i.e. the border
has a voxel not traced). If this happens, simply click on the “Undo last drawing” icon (3rd
icon from the left on the upper row of the Region of Interest toolbar [it looks like a
yellow pencil with a black tip on a 45 degree angle). Note: this undo feature can only be
used to undo the previous drawing (that is, you cannot undo 2 or more steps)

5. Continue to outline this ROI (i.e. the caudate) on each axial slice (from superior to

inferior) until the most inferior slice is outlined for the ROl around slice 57; any more
inferior [lower] does not contain left-side caudate. You can move from slice-to-slice with
the Up and Down arrows on the keyboard, or by changing the number that appears in
the Slice Viewer, or, you can simply use the wheel on the mouse between the left and
right buttons)

6. Click on the “View projection” icon (4™ icon from the left in the “Slice Viewer” toolbar).

The scan from the midpoint (i.e. the middle slice) of all 3 orientations (axial, sagittal,
coronal) should now be displayed simultaneously. The traced ROI should also appear on
the coronal (upper left) and axial (lower left) slices. Left clicking on any part of a slice in
any of the orientations will automatically change the slice number of the other 2 slice
orientations to match the voxel that you have just clicked. For example, clicking in the
middle of a large part of the caudate from coronal from slice 126 (you can change the
individual slice numbers from any of the 3 orientations whilst they are still displayed
simultaneously by altering the slice numbers x,y,z, just below the Slice Viewer toolbar.
Using “View projection” helps to verify that you have outlined (traced) the structure
correctly. That is, it helps to make sure that you have outlined the correct ROI; in this
case, it should all be grey matter, hence, if any white matter is traced from any
projection then those voxels will need to be erased. Erasing voxels (only from a single

29



Handbook of Structural Brain MRI Analysis. April 2015

orientation, not from View Projection”: Go to the slice where part of the ROl needs to be

deleted, then move the cursor over the voxel that you wish to remove, then hold down

the “Enter” key on the keyboard whilst also holding down the left mouse button.

Clicking on the right mouse button whilst holding down the “Enter” key will erase the

entire ROl on that slice. If you do this by accident, simply click on the “Undo last drawing”
icon

7. Once you are satisfied that your tracing of this ROl is accurate, “Save the ROI” (4™ icon
from the left on the upper row of the Region of Interest toolbar, or, from the ROI pull-
down menu) as “ch2bet_right_caudate.roi”

8. Calculate the volume of the ROI: the volume appears in the lower left of the “Region of
Interest” toolbar when the ROI is initially opened. So, you need to “Open ROIs”, select
on the ROI that you have just saved (i.e. ch2bet_right_caudate.roi), and click “OK”.
Important: don’t move the mouse because as soon as you move the mouse the volume
displayed disappears and is replaced by the co-ordinates of the cursor!!

9. Write down the volume displayed (which should be around 4.5-5.0cc)

Task 2: Open the “aal” image that is included in the MRIcro directory
(C:/ProgramFiles/MRIcro/). Move the mouse to the Talairach co-ordinates below and write
down the name of the ROI at these co-ordinates, including whether each set of x,y,z co-
ordinates represent the ROl on the right or left of the brain in Talairach space.

Table 1. Example of names of ROIs that represent Talairach co-ordinates.

ROI Talairach co-ordinate Right or Left Name of ROI
Number
X y z
1 -49 6 39 L Precentral gyrus
2 49 -54 32 R Angular gyrus
3 30 -11 -17 R Hippocampus
4 -8 -9 9 L Thalamus
5 -8 18 -2 L Caudate
6 48 18 -20 R Superior temporal gyrus
7 -8 0 60 L Supplementary motor area
8 -4 40 16 L Anterior cingulated gyrus
9 -14 -65 -3 L Lingual gyrus
10 20 3 1 R Globus pallidum
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10. Manual tracing of a Region Of Interest (ROI) in Analyze®

Double-click on the Analyze icon

Click on the far left icon that looks like a truck (“Load As”)

Click on the “File” button, and browse to the directory where the T1-weighted scan is
located

Select the header (.hdr) or image (.img) of the T1-weighted scan

Click on the “Open” button (bottom right of Load As module), or double click the
selected file in Step 4

Click on the “Load” button (bottom left of Load As module). The brain scan will now load
Click on the ROl icon (usually left of the EXIT icon on the far left of the tool bar [called a
Powerbar])

The ROl module should now have opened

Move to a slice where the brain is visible (e.g. middle slice). Alter the intensity
(“Intensity” icon on the far right of the Powerbar [on the top of the screen]) so that the
contrast between GM/WM/CSF is optimal. Note: the sliding bar of the Intensity setting is
very sensitive, so it often quicker to enter the Intensity Max and Min values manually
(once you have established then for one scan, the rest of the scans acquired with that
sequence on that scanner should be set to the same (if not identical) intensity levels)
Select the slice where you have chosen to begin tracing the ROI

Select the “Trace” icon (on the left) and hold down the left mouse button at the first
pixel. Whilst holding down the left mouse button, outline the ROI and then release the
left mouse button. A number will appear inside the ROI tracing to represent that ROI.
Name the ROI: View = Objects. Select the Object (named as its number) and name it as
the Name of the ROI. E.g. left_hipp means Left Hippocampus

Click on Done (lower right)

Move to the next slice (+ key on the keyboard or with the “Arrow” on the Powerbar) and
begin tracing the ROl on that slice. Repeat this until all slices have been traced for the
ROI

Save the traced ROI (File > Save Object Map)

To begin tracing a new ROI, select “New” from the “objects to define” located at the
lower right of the screen and repeat Steps 10 to 14 for further ROls.
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A visual guide of the conversion of .obj files to Analyze format:

1. Use Analyze

a. File -> Import/Export

£ s 1SMIEN BHE, Mmyn Chnie

Figure 11. The Import/Export module in Analyze®

b. Click on the ‘File-to-File button s

c. Select the object map to be modified (by using the ‘File’ button to browse)

1ol

Input

Directory IE'JBIHflmagas =

File

Information
File Format
Data Type
Dirmnensiors
Volume Number[1
Start Slice [
Nurber Slices [T

Output

Directory |E:¥E\F\/images ﬂ

File Iunamed
File Format |Ana\yzeAVW' ﬂ
™ Compressed

Convert Dlsp\ayl Done

Figure 12. The File-to-File option in the Import/Export module in Analyze®

d. Rename the output file

e. Assign the output file the ‘Analyzelmage 7.5’ file format. IMPORTANT: A bug in this
module is as follows: if you Assign the output file format BEFORE naming the new output file

then this entire file-to-file process will NOT work! SO, BE SURE TO CARRY OUT STEP D.
BEFORE STEP E AND F.

f. Click on the ‘Convert’ button

g. Click on the ‘Done’ button
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11. Steps for 3D rendering in ITK-SNAP of ROI (object maps) traced in Analyze

Open Analyze

File > Import/Export

File-to-File icon (far left icon)

Browse for the tracing (object map) to be converted, and select it
Change output name to something relevant

Change new format to “Analyze 7.5”

Convert

Done

Open ITK-SNAP (Yushkevich et al., 2006)

. Open T1-weighted image (.hdr) as “Load Data/Greyscale Image”
. Open the newly converted Analyze 7.5 format object map (.img) as “Load

Data/Segmentation Data”

Then fiddle with label colours, transparency, and intensity (Options, Display curves,

then hold-and-move the 2 dots along the graph’s diagonal line)

NOTE: you must change the voxel dimensions of the Analyze 7.5 format tracing; USE

MRIcro = note that voxels are 0 x 0 x 0 mm in MRIcro > change these number to 1.00 x

1.00 x 1.00mm (NOTE: figure below) so that they match the T1-weighted scan voxel

dimensions

yY[217 jJ|0,00 = B

Z[181 =3\0.00 =H7300 =

16:bit int e-endian Intel |
:|1U25 _,3 Volumes |1 __,Z'
of[1:000001 =] Irtercept [0.000001 =3

Viewer

Rarae®

Figure 13. Fields that must be changed to match voxel dimensions of the T1-weighted scan.
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14. 12) “Update mesh” (bottom of screen)

update mesh  resetview [

Figure 14. The “update mesh” button in ITK-SNAP

15. Then fiddle with label colours, transparency, and intensity (Options, Display curves,
then hold-and-move the 2 dots along the graph’s diagonal line)

16. To view the 3D rendering in its own screen, press “+” at the bottom of the screen, as
follows:

update mesh reset wiam @ -I-

Figure 15. Maximizing the 3D-rendered ROl in INTK-SNAP.

M 1TK-SNAP 1.6.0-rc2: ch2.hr - ke_heschiimg o LR
Ele  Qptions  Help +
IRES Toolbex -]

= -

& L & 7

¢

Tool Options
Crosshairs Tool
ensty.  Labsl
=) 100
Lo g srigtion
Labei 100

P Syncheonae cursoe
Sagmentaton Opions

Actve craang ibst
[ar3 v

> S
&

Figure 16. An example of a left Heschl gyrus traced in Analyze and then 3D-rendered in

ITK-SNAP.
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12. Inter-rater reliability

Inter-rater reliability = ((Rater A — Rater B) / ((Rater A + Rater B) / 2)) * 100
In other words, the percentage difference between the Raters.

The other way to calculate inter-rater reliability is in SPSS with “intraclass correlation”. The
reference is Shrout & Fleiss (1979). Or, simply calculate “kappa”.
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13. Freesurfer

Freesurfer (Fischl et al., 1999) is a great program for conducting group T1-weighted
(structural) analyses. It calculates volume, thickness, area and curvature of dozens of ROls.
To process a scan through Freesurfer:

1. Download Freesurfer: note whether your computer is 32-bit or 64-bit
2. Copy it to the desktop of your Linux operating system

3. Open a terminal

4. Type the following: sudo mv freesurfer-<version> /usr/local/

5. Extract the freesurfer file by typing the following (from /usr/local/):
sudo tar xzvf freesurfer-<version>-full.tar.gz

6. Copy your .license into the /usr/local/freesurfer directory by typing:
sudo mv .license /usr/local/freesurfer

7. Download and install tcsh by either downloading and installing online by:
a) typing the following: sudo apt-get install tcsh

or

b) Download it from another computer and then copy it across to the desktop of your Linux
operating systems and type in the following from a terminal (from ~/Desktop):

sudo dpkg —i tcsh

8. Then modify the tcsh file so that the following 2 lines appear:

setenv FREESURFER_HOMIE <freesurfer_installation_directory>/freesurfer

(which in our case would be: setenv FREESURFER_HOME /usr/local/freesurfer)

source SFREESURFER_HOME/SetUpFreeSurfer.csh

If done correctly then those 2 lines should load when you type in ‘tcsh’ from a terminal
9. Give permission to write in the /usr/local/freesurfer/subjects/ directory by typing:
sudo chmod 777 /usr/local/freesurfer/subjects

10. Test the installation by typing in: tkmedit bert orig.mgz (to see an example) and then
tksurfer bert rh pial (to see an example). Have a play and then close the program.
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11. Copy a subject’s dicoms into a directory under the directory
/usr/local/freesurfer/subjects/
12. Let’s say the subjects is called ‘controll’ and the first dicom is called IM1.dcm

13. From a terminal in the /usr/local/freesurfer/subjects/ directory type in 1 single
command to execute all 31 steps of Freesurfer:

recon-all —s controllnew —i control1/IM1.dcm —all
Note: for Step 8: cd (to make sure you are in your home directory)

It’s also a good idea to include T2 data to optimise the pial segmentation. To perform recon-
all to incorporate the T2 data:

recon-all -s <SUBJECT_ID> -i <SUBJECT_ID>/T1/IM1.dcm -T2 <SUBJECT_ID>/T2/IM1.dcm -
all -T2pial

FS hippocampal subfields

To perform hippocampal subfield segmentation, add the following flag to the end of your
recon-all command:

-hippo-subfields
sudo gedit .tcshrc

e Inaround 8 to 24 hours (depending upon the scan contrast and computer resources) the
scan will be fully processed. It takes a long time because 31 processes are occurring for
each hemisphere of data

e Freesurfer is multi-threaded, so it can use all of the CPU cores you have available

14. After each T1-weighted scan has been processed via recon-all, you can view the results
by typing in the following (as a single command line):

tkmedit nameofscan norm.mgz —segmentation aseg.mgz

SFREESURFER_HOME/FreeSurferColorLUT.txt

15. To view the 3D rendering, type in the following:

tksurfer nameofscan rh pial

(To look at the left hemisphere type tksurfer nameofscan lh pial)
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Note: to visualize only specific gyri using tksurfer; follow these instructions (contributed by
Phillip Law):

16.

Load existing label: File -> Label -> Load Label -> Browse -> <select label file> (e.g.,
Ih.aparc.annot for left hemisphere or rh.aparc.annot for right hemisphere) -> Press ‘OK’ ->
Press ‘OK’.

Select and mark ROI(s): Left click on ROI and press Mark Label icon (=% ; marked ROI will
turn white).

e To select another ROI, repeat step 2.

Create marked label from selected ROI(s): Click New Label from Marked icon (il).

Save custom marked label: File -> Label -> Save Selected Label -> <enter filename> -> Press
‘oK’

Restart Freesurfer

Load custom marked label: File -> Label -> Load Label -> Browse -> <select label saved in step
4> -> Press ‘OK’ -> Press ‘OK’.

Change color of marked label: Click Change label color icon (—| ).

For group analysis, you then need to smooth the data via the “qcache” command. That
is, for each scan, type in the following:

recon-all —=s controllnew —qcache

The —qcache takes around 10 to 30 minutes for each scan, depending upon how many
scans you are simultaneously processing, and the available computer resources

After each scan has finished the gcache procedure, you need to create a “plain text”
document that is the matrix. For example,

Fsid diagnosis sex age

Id1 control f 20

Id2 control m 24

Id3 clinical m 21

Id4 clinical f 24

Then save it as something like “qdec_table” (in plain text format)
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e Next, you need to make a “diagnosis” plain text file, something like:
control
clinical

e Then save it as “diagnosis” (in plain text format)
e Now make another file for the “sex” column, as follows:

And save it as “sex” (in plain text format).

e Now run the Freesurfer GLM program called “qdec”: Type in “qdec”
e A GUI (graphical user interface) will now open (Figure 17).

|r_11: Edit ¥iew Windaw Help

B AR g4 ARH00eeD @ + W N iGotoe vertex number:
load a i s I
§ sign[Displa P
fdat fine z_q E :

rfinto the [

[ hesign freesur fer/subjec
Dt ab

[ TETFTeEeaT/ freesurfer/subjec
Mumber of Subjects: [

Comman space Subject:iffsaveral,,
bats Table View ‘

Discrete and Continuaous Fact
diagnosis

s e x

age

jove Selection from Data Tab
Stats Data Import x
Generate Stats Data Tablas
Subject Exclusions x| 0.4
Selected Factor:|fcnone selec
Greater Than:

Less IT'han

Equal Ta

Clear Exclusions

File

Figure 17. The QDEC GUI.

e Open the matrix table (the .dat file you made that contains the matrix data, the one

called “qdec_table.dat”)

e Then, click on the “Generate Stats Data Tables”. This will import all of the data pulled

from the scans’ “surf” directories included in the gdec_table file

e Select the pull-down menu from that tab (which now states “none selected”) and select

“aseg.volume” (Figure 18).
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View Window Help ‘
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Figure 18. The QDEC GUI with a stats table loaded.

e Select the “Design” tab, and change “thickness” to be “volume” (Figure 19).
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Figure 19. The Design section of QDEC.

e Click on the “diagnosis” option in the “Discrete (Fixed Factors)” window (Figure 20).
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File Edit Yiew Window Help
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Figure 20. The Discrete (Fixed Factors) section of QDEC.

Click on the “Analyze” button at the bottom. You will see the progress bar (in blue)

[ ]
moving in the bottom right of the screen from 0% to 100% (can take a few moments to
process)

e A new window will now appear called “Display” that shows the “inflated” brain in 3D

e Select the second option in the left window (e.g. “Does the average volume differ
between control and clinical?”)

e The uncorrected results (vertices) will now appear over the inflated brain (Figure 21). To

visualise the pial surface, click on “pial” (near the top of the Display tab) or “white” to

see white matter
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File Edit VYiew Kindow Help
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Opacity:!
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Figure 21. Uncorrected results superimposed over the inflated brain in QDEC.

e To analyze results for multiple-comparisons, used either FDR (false discovery rate), or
the less stringent Monte Carlo Null-Z simulation:

e Change the default Threshold of 2.0 (0.01) to 1.3 (0.05) from the drop-down menu next
to the word “Threshold”

e Click on the “Run” button

e Within a few seconds, the multiple-comparisons results will be superimposed in 3D over

the inflated brain (Figure 22). In the example below, there are significant differences
over the left superior parietal lobe, as seen in the terminal (Figure 23) which also states
the significance values for that cluster as well as its Talairach co-ordinates and size (in
mm?). Note that the significance values in Freesurfer are stated as -log(10). As a guide, a
value of 2.0 is equivalent to p=0.01, and 1.3 is equivalent to p=0.05.
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Eile Edit Yiew Kindaw Help
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Figure 22. Corrected results superimposed over the inflated brain in QDEC.
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# Area Threshol d 0 mm2

# CSD thresh 1. 300000

# CSD nreps 10000

# CSD sintype null-z

# CSD contrast NA

CSD confint 90. 000000

# Overal | max 2. 1485 at wvert 9

# Overal |l mn -4. 94487 at e 44549
# NCl usters 1

# Total Cortical Surface Area 65416.6 (rmmT2)
EFixMI =1

# ClusterMo Max VixMex Size(nm™2) TalX Taly TalZ ane CWPLow C
NPH Mvixs  Annot

1 -4.124 10868 3785.71 -14.3 -8l1.5 37.3 0.00010 0.00000 O.
0020 6266 superiorparietal

Figure 23. QDEC statistics output are displayed in the terminal.

To process thickness, area, or curvature analysis, navigate back to the “Subjects” tab,
drop down the pull-down menu, and select the type of analysis you want to investigate.
Then, navigate to the “Design” tab and change “volume” to what you want to look at,
then “Analyze”. Note that the left hemisphere was processed first, so you need to select
the right hemisphere if you want to look for significant differences in the right
hemisphere

Note that you can also use covariates or nuisance factors (in the “Design” tab) by clicking
on them
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NOTE: To change the working directory, for example, to a directory called “mydirectory”,
type in the following BEFORE typing in tcsh:
export SUBJECTS_DIR=/usr/local/freesurfer/subjects/mydirectory

NOTE: when running the recon-all command you MUST have the fsaverage subdirectory in
your working directory

How to create volume and thickness statistics of BA regions and V1 and V2 (primary and

secondary visual areas)

First extract the data from the Freesurfer output (this will take a few hours per subject):
recon-all —s controllnew —qcache

Then extract the thickness data into a text file (replace “thickness” with “volume” for
volumetrics):

aparcstats2table --hemi |h --subjects subjectl subject2 subject3 --parc BA --meas thickness -
-tablefile ba_v1_v2_|h_thickness.txt

aparcstats2table --hemi rh --subjects subjectl subject2 subject3 --parc BA --meas thickness
--tablefile ba_v1l v2_ rh_thickness.txt

How to export the data from Freesurfer into SPSS

1. After you have conducted a QDEC analysis, a new directory will have been created in the
“gdec” directory called “stats_tables”. Navigate to this directory

2. Copy all of the files in the directory (they will all have a .dat extension) onto a Windows
computer

3. Open MS Excel
Select on a .dat file (although it may appear with a .stats extension) and then open it
(you may have to select “delimited”, then “tab”)

5. Save the file in Excel 97-2003 format

6. Close Excel

7. Open SPSS

8. Change the option in the navigation window to show “All files”

9. Select the Excel file which you have just saved

10. The Excel file will now open in SPSS.

11. Save As

12. Complete this process for all of the .dat files

13. Once all .dat files have been converted to SPSS format, merge them (using the merge
feature in SPSS: Data = Merge Files > Add variables)
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14. Protocol to process SWI images from magnitude and phase data

Use SPIN

Process 2> MIP/SWI processing (Figure 24)

Option 2 (MIP with Phase multiplication)

Phase masking: use “positive”

Select Phase (2" dicom folder)

Select Magnitude (1% dicom folder)

Number of slices for each MIP: 1

Number of multiplications: play with it, but default is 4 (watch for false positives if
use a higher value)

MIP prefix (=SWI image): change to a meaningful name
High pass filter: 160

11. Vertical slice: 160

12.

Note: reduce HP filter and Vertical slice (e.g. 64) to show “more” vasculature but will
increase artefact

-

MIP with Phase Multiplications

| ==
Fhase Masking High Pass Filter Advanced
™ Use Negative Harizartal Size:  |B4 Skip: 1

Usze Positive ertical Size: E4

e
" Use Bath DICOM Series: |0
Fislice] Size: 0 eries:
" Use Negative Linear [slice) Size

~

Ilze Positive Linear [ Image Order Descend

Phase Zero: [2045 7 At I Output Mask image
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{+ Harining ™ Hamming " Harmming with R amp

Select the start magnitude image

|E:'\cda\tbi2'\time1 NSWI_TBI_002_181071%SPECIFIC_TRIALS _JER Browse

Select the start phaze image

|E:'\cda\tbi2'\time1 NSW_TBI_002_181071%SPECIFIC_TRIALS _JEF Browese
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Total number of magnitude/phase images to go through 112 v Process Entire Series
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T
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i

Figure 24. Options within SPIN for processing SWI images from phase and magnitude data
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15. FSL (Linux/MAC)

FSL (Smith et al., 2004) includes a number of modules for T1-weighted and DTl analyses,
although it can also be used for fMRI processing.

To install fsl in bash, type in the following (it is best to add this to the setup file):

FSLDIR=/usr/local/fsl
. ${FSLDIR}/etc/fslconf/fsl.sh
PATH=${FSLDIR}/bin:${PATH}

export FSLDIR PATH

Alternatively, you can download an automated installation script
(http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/Fslinstallation )

After typing in “fsl” in the console a GUI will appear (Figure 25).

‘D0OKXFL410 |

BET brain extraction

SUSAN noise reduction

FAST Segmentation

FLIRT linear registration

FEAT FMFRI analysis

MELODIC ICA

FDT diffusion

POSSUM MR simulator

|
|
l
|
l
|
l
|
i

Misc | it | e ;

Figure 25. The FSL GUI.
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BET (Brain extraction tool): This strips the skull and eyes from the scan to leave just brain.
Very useful, very accurate, and very quick.

FAST (Fully Automated Segmentation Tool): input your BET’ed T1-weighted scan, and after a
few second the output will be GM, WM, and CSF, saved as separate images as well as
volumetrics for each of these components.

Some tips on settings and interpretation of FSL FAST output viewing in MRIcro

Change the colour to HOT METAL

Change the following intensity and contrast value as follows:

Black=0

White = 4

Colours for each component:

TIS1 (WM) = orange
TIS2 (GM) = red

CSF = blue

NOTE: There are MANY packages available to compute grey matter, white matter, and CSF
volumes from T1-weighted scans, including FSL (FAST), SPM, Freesurfer, and many more...
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16. Tract-Based Spatial Statistics (TBSS) which is part of FSL

For every subject’s DTl scan, you must complete the following pre-processing steps:
Convert each scan to FSL 4D NIfTI nii format (via dcm2nii; this produces 3 files: a big
data file (.nii) + a small .bvec file + a small .bval file; Figure 26)

‘i Drag and Drop DICOM to NIfTI converter - =

File Edit Help
Output Format: | FS|_ (4D MIFTI nil -

Chrig Rorden's demnii ;7 July 2009 -

Figure 26. Use the correct option for converting dicoms to FSL (4D NIfTi nii) format.

Eddy current correct the niifti scan by doing the following:

Type in “fsl”

Select “FDT diffusion” (Figure 27).

Click on the drop-down box and select “Eddy current correction”

@@ @ FDT - FMRIB's Diffusion Toolbox 2.0

Eddy cuwrrent correction —l|

Diffusion weighted data:l %

Corrected output data:l =

]
Eeference volume |8 =
6o | Ex it | Helop |

Figure 27. The FDT GUI in FSL.

Open the directory where your .nii file is and select it. The default output file will be
called “data.nii.gz”

Click “Go”. The eddy current correction takes at least 5 minutes to process, depending
upon the number of directions and number of slices to be processed. After it has
completed, click on the “OK” (in the “Done” box), then “Exit” on the FDT box.

Exit FSL

In the terminal, navigate to the directory you are working with, and type in the following
which will extract the first volume of your data (i.e. the b-zero [T2-weighted scan]) and
labels it as nodif):

10. fslroi data.nii.gz nodif 0 1
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11. bet nodif.nii.gz nodif_brain -m —f 0.3 (this command BETs the no diffusion (b=zero) scan
and then masks it as a value of 0.3 which works well for most head sizes)

12. Then, type in “fslview”

13. File = Open (select the output of the eddy current correction process called “data”)

14. Open the mask in fslview (File 2 Add, then select the file nodif_brain_mask) and then
edit the mask (don’t forget to click the ‘lock’ box [icon at the bottom of the screen that
looks like a padlock]). Tools = Single, then axial view of the scan and mask will appear
on the right-hand side of the screen (Figure 28).

15. Click on the button that looks like a pencil, and change the numbers in the 2 boxes from
1to 5 (these represent the number of voxels (in 3 directions). Use the + and — buttons
(or the scroll button on the mouse, or PageUp and PageDown) to navigate up and down
the axial slices)

Slider bars Click this button to engage the pencil tool

g
=

/ Transparency level

Click this button to unlock

-

Figure 28. The FSLview interface displaying a T2-weighted image with a mask superimposed.

16. When you have finished editing the mask, File = Save As, and save the mask as “mask1”.

17. Fit the diffusion tensor model using the DTIFIT toolbox (within FSL; i.e. select FDT
Diffusion button), then DTIFIT Reconstruct diffusion tensors, and then select the box
“specify input files manually”. To create the .bvec and .bval files, open them in Excel

49



Handbook of Structural Brain MRI Analysis. April 2015

(separately), transpose them, copy them into Notepad, then save them as separate plain
text files

18. Select the correct files (data, mask1, output name, gradient directions (.bvec) and b-
values (.bval).

19. Click “Go”

THEN, you are ready for group analyses, as follows:

1. Navigate to the “mytbss” directory and type in the following (analyses MUST be run
from a directory called mytbss, and you MUST have the template in that directory called
FA_2_ FMRIB58_1mm.cnf, unless you choose to use your own template)
tbss_1_preproc *.nii.gz

3. After a few minutes, a message will appear in the terminal suggesting step 2 (which will
take around 5 to 15 minutes per scan, depending upon the scan dimensions and your
computer’s resources), but first, check the output of tbss_1 by navigating to the
mytbss/FA/slicesdir directory and double-clicking on the file called “index.html”: this will
display 9 slices from each subject’s scan — check that none are upside down, back to
front, or too bright or dull. To flip a scan along x, y, or z, try different combinations of the
following command: fslswapdim data.nii.gz z y x dataoutput.nii.gz. If upside down, try:
fslswapdim data.nii.gz —x y —z dataoutput.nii.gz

4. After you are sure each scan is in the correct orientation, proceed to the next step:

5. tbss_2 reg-T

6. tbss_3 postreg-S

7. Now you can check the output by typing the following:

8. cd stats

9. fslview all_FA —b 0,0.8 mean_FA_skeleton —b 0.2,0.8 —| Green

10. For Step 4 (thesholding, which will take a minute or two), type in the following:

11. tbss_4 prestats 0.2

12. Now run the group stats. For this, first check the order of your scans by typing:

13.cd FA

14. imglob *_FA.* This will list all of the subjects’ data in the order to be processed

15. Then run the analysis:

16. cd ../stats

17. design_ttest2 design 7 11  (this makes the matrix; note the numbers in this example
are for comparing group 1 with N=7 versus group 2 with N=11)

18. Then type the following (will take a few hours to process)

19. randomise -l all_FA_skeletonised —o tbss -m mean_FA_skeleton_mask —d design.mat
-t design.con —n 5000 -T2 -V

20. To view the results, type in the following:

21. fslview SFSLDIR/data/standard/MNI152_T1_1mm mean_FA_skeleton -l Green —b
0.2,0.8 thss_corrp_tstatl —| Red-Yellow -b 3,6 thss_tstat2 —| Blue-LightBlue —-b 3,6
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22. Note: thss_p_tstat is the UNCORRECTED result, thss_corrp_tstat is the CORRECTED
result.

Note: to view significant differences at p=0.05, change the first slider bar (Min) to 0.95
(enter it manually rather than using the slider bar), and the value below it (Max) to 1 (as 1-
0.95=0.05).

To process non-FA data:

1. Create a directory for each non-FA dataset (e.g. L1, L2, L3, MD, radial diffusivity)
Copy over the relevant data into those directories
Rename each file in the non-FA folders to be EXACTLY the same names as listed in the
original FA dataset (which will now be in a directory called “origdata”). For example, if
your original (FA) data ended in the filename _FA.nii.gz then you must rename your non-
FA data file to also end in _FA.nii.gz You can do this by carrying out the follow
commands within each directory:

foriin./*L1*;do mv --"Si" "${i//L1/FA}";done
foriin./*L2*;do mv -- "Si" "${i//L2/FA}";done
foriin./*L3*;do mv -- "Si" "${i//L3/FA}";done
foriin./*MD*;do mv -- "Si" "${i//MD/FA}";done

4. Typein “tbss_non_FA L1” (from the mytbss directory) to begin processing the L1 data
cd stats

6. randomise -l all_L1_skeletonised —o tbss_L1 -m mean_FA_skeleton_mask -d
design.mat —t design.con —n 5000 -T2 -V

To name the white matter bundle where there are significant voxels, open the built-in
atlases (Tools = Toolbars = Atlas tools) and then select the voxel of interest: the atlases
will state the name of the white matter fibre that click on.

NOTE: to create radial diffusivity data (the average of L2 and L3), type in the following script
(created by Dr Kerstin Pannek) from your working directory:

12dir="L2" #edit this line
13dir="L3" #edit this line
cd Sl2dir

list="Is *.nii.gz’
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cd../
mkdir radial_diffusivity
for x in Slist
do
echo "calculating radial diffusivity for $x"
fsimaths $l2dir/$x -add SI3dir/$x -div 2 radial_diffusivity/$x
done

Presenting the results

If you don’t like typing commands, then follow these steps to show the results (assuming
there is greater FA in the first group):

Open fslview

File = Open

Select the file called “all_FA.nii.gz”

Select the file called “all_FA_skeletonized.nii.gz”
Select the file called “tbss_tfce_corrp_tstatl.nii.gz”
Change the Min value to 0.95 and the Max value to 1

NoukwnNeE

The red-yellow voxels are the voxels of FA that are significantly greater in the first group

(if there is greater FA in the second group, then these voxels will appear after loading

tbss_tfce corrp_tstat2.nii.gz)

8. To show the results in 3d, select “Tools” then “3D Viewer” and adjust the transparencies
accordingly

9. If you want to show the differences more easily, then you need to use the “fill”

command that makes the white matter voxels thicker so they are more easily visualised:

tbss_fill tbss_tfce_corrp_tstatl 0.95 mean_FA tbss_fillFAp95

That command will apply the “tbss_fill” command to the file called “tbss_tfce_corrp_tstatl”,
threshold it at a p-value of 0.95, and save the output as “tbss_fillFAp95”

The result (tbss_fillFAp95) can then be added in fslview.
If you want to show these results using a Windows program, then use MRlcro:

File = Open

Select the T1-weighted or MNI DTI template

Overlay - Load image overlay

Select “tbss_fillFAp95”

The tbss_fillFAp95 will now be superimposed onto the template

o kwnNRE

To show the differences slice-by-slice, click on the “Etc” pull-down menu then select
“Options”
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7. Enter the slice numbers you want to display, and whether you want to show left
hemisphere over right (or the other way around), the extent of slice overlap, and
whether you want to display transverse (axial) or coronal slices, then click “OK”. Figure
29 is an example of the screen after you have completed this (the top row is slice by slice
with significant FA voxel at a p-value of 0.05, and the bottom row is fslview using the 3d

viewer; merged in Powerpoint):

Figure 29. TBSS results presented from axial and 3D-rendered perspectives.

Note about eddy current and movement correction:

For each subject, it is advisable to create individualised gradient tables (.bvec) based on the
ecclog (called “data.ecclog”, which is an output file after correction is complete in FSL), as
suggested by Leemans and Jones (2009) and Rohde et al. (2004). To do this, type in the
following fdt_rotate_bvecs command:

fdt_rotate_bvecs nameoforiginalgradienttable.bvec nameofnewgradienttable.bvec
data.ecclog

Sometimes you will need to transpose (easiest to do this in Excel) the original gradient table
because fdt_rotate_bvecs expects the original bvec file to be 3 columns (not 3 rows)

53



Handbook of Structural Brain MRI Analysis. April 2015

To extract mean value for ROIs according to the JHU White Matter Atlas

You need to extract the ROIs from the Atlas and convert them into masks; they are
numbered as “intensities” when viewed with FSLview. For example, corpus callosum (middle)
is 4.

First, copy the file “JHU-WhiteMatter-labels-1mm.nii.gz” from the fsl/atlases directory into
your tbhss/stats directory. Then extract the ROIs (to make them masks) with the following
commands (script created by Melissa Kirkovski):

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 1 -uthr 1 cer_peduncle
fsimaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 2 -uthr 2 pontine_crossing_tract
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 3 -uthr 3 ant_CC

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 4 -uthr 4 CC

fsimaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 5 -uthr 5 post_CC

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 7 -uthr 7 R_corticospinal_tract
fsimaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 8 -uthr 8 L_corticospinal_tract
fsimaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 11 -uthr 11 R_Inf_cer_peduncle
fsimaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 12 -uthr 12 L_Inf_cer_peduncle
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 13 -uthr 13 R_Sup_cer_peduncle
fsimaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 14 -uthr 14 L_Sup_cer_peduncle
fsimaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 15 -uthr 15 R_cer_peduncle
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 16 -uthr 16 L_cer_peduncle
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 17 -uthr 17 r_alic

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 18 -uthr 18 |_alic

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 19 -uthr 19 r_plic

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 20 -uthr 20 |_plic

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 23 -uthr 23 R_Ant_cor_rad
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 24 -uthr 24 L_Ant_cor _rad
fsimaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 25 -uthr 25 R_Sup_cor_rad
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 26 -uthr 26 L_Sup_cor_rad
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 27 -uthr 27 R_Post_cor_rad
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 28 -uthr 28 L_Post_cor_rad
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 31 -uthr 31 R_ilf

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 32 -uthr 32 L_ilf

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 33 -uthr 33 R_unc

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 34 -uthr 34 L_unc

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 35 -uthr 35 R_cing

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 36 -uthr 36 L_cing

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 37 -uthr 37 R_cing_hipp
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 38 -uthr 38 R_cing_hipp
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 39 -uthr 39 R_hipp

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 40 -uthr 40 L_hipp

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 41 -uthr 41 R_slf

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 42 -uthr 42 L_slf

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 45 -uthr 45 R_unc_needsTBC
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 46 -uthr 46 L_unc_needsTBC
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 47 -uthr 47 R_tapetum
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 48 -uthr 48 L_tapetum

Then, apply the “fsimeants” command to extract the values within each ROI (mask) from your all_FA.nii.gz file:
FA

fslmeants -i all_FA.nii.gz -0 FA_mean_cer_peduncle.txt -m cer_peduncle.nii.gz

fslmeants -i all_FA.nii.gz -0 FA_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz
fslmeants -i all_FA.nii.gz -o FA_mean_ant_CC.txt -m ant_CC.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_CC.txt -m CC.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_post_CC.txt -m post_CC.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz
fsimeants -i all_FA.nii.gz -0 FA_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz
fslmeants -i all_FA.nii.gz -0 FA_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz
fsimeants -i all_FA.nii.gz -0 FA_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz
fsimeants -i all_FA.nii.gz -0 FA_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz
fsimeants -i all_FA.nii.gz -0 FA_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz
fsimeants -i all_FA.nii.gz -0 FA_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz
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fsimeants -i all_FA.nii.gz -0 FA_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz
fsimeants -i all_FA.nii.gz -o FA_mean_r_alic.txt -m r_alic.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_|_alic.txt -m |_alic.nii.gz

fsimeants -i all_FA.nii.gz -o FA_mean_r_plic.txt -m r_plic.nii.gz

fsimeants -i all_FA.nii.gz -o FA_mean_|_plic.txt -m |_plic.nii.gz

fslmeants -i all_FA.nii.gz -0 FA_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz
fsimeants -i all_FA.nii.gz -0 FA_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz
fsimeants -i all_FA.nii.gz -o FA_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz
fslmeants -i all_FA.nii.gz -o FA_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz
fslmeants -i all_FA.nii.gz -o FA_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz
fslmeants -i all_FA.nii.gz -0 FA_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz
fslmeants -i all_FA.nii.gz -o FA_mean_R_ilf.txt -m R_ilf.nii.gz

fsimeants -i all_FA.nii.gz -o FA_mean_L_ilf.txt -m L_ilf.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_R_unc.txt -m R_unc.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_L_unc.txt -m L_unc.nii.gz

fsimeants -i all_FA.nii.gz -o FA_mean_R_cing.txt -m R_cing.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_L_cing.txt -m L_cing.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz
fslmeants -i all_FA.nii.gz -0 FA_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz
fslmeants -i all_FA.nii.gz -o FA_mean_R_hipp.txt -m R_hipp.nii.gz

fslmeants -i all_FA.nii.gz -0 FA_mean_L_hipp.txt -m L_hipp.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_R_slf.txt -m R_slf.nii.gz

fslmeants -i all_FA.nii.gz -0 FA_mean_L_slf.txt -m L_slf.nii.gz

fslmeants -i all_FA.nii.gz -o FA_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz
fslmeants -i all_FA.nii.gz -0 FA_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz
fslmeants -i all_FA.nii.gz -o FA_mean_R_tapetum.txt -m R_tapetum.nii.gz
fslmeants -i all_FA.nii.gz -o FA_mean_L_tapetum.txt -m L_tapetum.nii.gz

L1

fslmeants -i all_L1.nii.gz -0 L1_mean_cer_peduncle.txt -m cer_peduncle.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz
fslmeants -i all_L1.nii.gz -0 L1_mean_ant_CC.txt -m ant_CC.nii.gz

fslmeants -i all_L1.nii.gz -o L1_mean_CC.txt -m CC.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_post_CC.txt -m post_CC.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz
fslmeants -i all_L1.nii.gz -0 L1_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz
fslmeants -i all_L1.nii.gz -0 L1_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz
fsimeants -i all_L1.nii.gz -0 L1_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz
fslmeants -i all_L1.nii.gz -0 L1_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz
fslmeants -i all_L1.nii.gz -0 L1_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz
fsimeants -i all_L1.nii.gz -0 L1_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz

fsimeants -i all_L1.nii.gz -0 L1_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz

fslmeants -i all_L1.nii.gz -o L1_mean_r_alic.txt -m r_alic.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_|_alic.txt -m I_alic.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_r_plic.txt -m r_plic.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_|_plic.txt -m |_plic.nii.gz

fsimeants -i all_L1.nii.gz -0 L1_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz

fsimeants -i all_L1.nii.gz -0 L1_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz

fsimeants -i all_L1.nii.gz -0 L1_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz

fsimeants -i all_L1.nii.gz -0 L1_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_R_ilf.txt -m R_ilf.nii.gz

fslmeants -i all_L1.nii.gz -o L1_mean_L_ilf.txt -m L_ilf.nii.gz

fsimeants -i all_L1.nii.gz -0 L1_mean_R_unc.txt -m R_unc.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_L_unc.txt -m L_unc.nii.gz

fsimeants -i all_L1.nii.gz -0 L1_mean_R_cing.txt -m R_cing.nii.gz

fsimeants -i all_L1.nii.gz -0 L1_mean_L_cing.txt -m L_cing.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz

fsimeants -i all_L1.nii.gz -0 L1_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz

fslmeants -i all_L1.nii.gz -o L1_mean_R_hipp.txt -m R_hipp.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_L_hipp.txt -m L_hipp.nii.gz

fsimeants -i all_L1.nii.gz -o L1_mean_R_slf.txt -m R_slf.nii.gz

fsimeants -i all_L1.nii.gz -o L1_mean_L_slf.txt -m L_slf.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz
fsimeants -i all_L1.nii.gz -0 L1_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz
fsimeants -i all_L1.nii.gz -0 L1_mean_R_tapetum.txt -m R_tapetum.nii.gz

fslmeants -i all_L1.nii.gz -0 L1_mean_L_tapetum.txt -m L_tapetum.nii.gz

L2

fslmeants -i all_L2.nii.gz -0 L2_mean_cer_peduncle.txt -m cer_peduncle.nii.gz
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fslmeants -i all_L2.nii.gz -0 L2_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz
fsimeants -i all_L2.nii.gz -0 L2_mean_ant_CC.txt -m ant_CC.nii.gz

fsimeants -i all_L2.nii.gz -0 L2_mean_CC.txt -m CC.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_post_CC.txt -m post_CC.nii.gz

fsimeants -i all_L2.nii.gz -0 L2_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz
fsimeants -i all_L2.nii.gz -0 L2_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz
fslmeants -i all_L2.nii.gz -0 L2_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz
fsimeants -i all_L2.nii.gz -0 L2_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz
fsimeants -i all_L2.nii.gz -0 L2_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz
fslmeants -i all_L2.nii.gz -0 L2_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz
fsimeants -i all_L2.nii.gz -0 L2_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz

fsimeants -i all_L2.nii.gz -0 L2_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_r_alic.txt -m r_alic.nii.gz

fsimeants -i all_L2.nii.gz -0 L2_mean_|_alic.txt -m |_alic.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_r_plic.txt -m r_plic.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_|_plic.txt -m |_plic.nii.gz

fsimeants -i all_L2.nii.gz -0 L2_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz

fsimeants -i all_L2.nii.gz -0 L2_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_R_ilf.txt -m R_ilf.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_L_ilf.txt -m L_ilf.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_R_unc.txt -m R_unc.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_L_unc.txt -m L_unc.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_R_cing.txt -m R_cing.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_L_cing.txt -m L_cing.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_R_hipp.txt -m R_hipp.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_L_hipp.txt -m L_hipp.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_R_slf.txt -m R_slf.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_L_slf.txt -m L_slf.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz
fslmeants -i all_L2.nii.gz -0 L2_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz
fslmeants -i all_L2.nii.gz -0 L2_mean_R_tapetum.txt -m R_tapetum.nii.gz

fslmeants -i all_L2.nii.gz -0 L2_mean_L_tapetum.txt -m L_tapetum.nii.gz

L3

fslmeants -i all_L3.nii.gz -0 L3_mean_cer_peduncle.txt -m cer_peduncle.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz
fslmeants -i all_L3.nii.gz -0 L3_mean_ant_CC.txt -m ant_CC.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_CC.txt -m CC.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_post_CC.txt -m post_CC.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz
fslmeants -i all_L3.nii.gz -0 L3_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz
fslmeants -i all_L3.nii.gz -0 L3_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz
fslmeants -i all_L3.nii.gz -0 L3_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz
fsimeants -i all_L3.nii.gz -0 L3_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz
fslmeants -i all_L3.nii.gz -0 L3_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz
fslmeants -i all_L3.nii.gz -0 L3_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_r_alic.txt -m r_alic.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_|_alic.txt -m |_alic.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_r_plic.txt -m r_plic.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_|_plic.txt -m |_plic.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_R_ilf.txt -m R_ilf.nii.gz

fslmeants -i all_L3.nii.gz -o L3_mean_L_ilf.txt -m L_ilf.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_R_unc.txt -m R_unc.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_L_unc.txt -m L_unc.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_R_cing.txt -m R_cing.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_L_cing.txt -m L_cing.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_R_hipp.txt -m R_hipp.nii.gz

fslmeants -i all_L3.nii.gz -0 L3_mean_L_hipp.txt -m L_hipp.nii.gz
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fsimeants -i all_L3.nii.gz -0 L3_mean_R_slf.txt -m R_slf.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_L_slf.txt -m L_slf.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz
fslmeants -i all_L3.nii.gz -0 L3_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz
fsimeants -i all_L3.nii.gz -0 L3_mean_R_tapetum.txt -m R_tapetum.nii.gz

fsimeants -i all_L3.nii.gz -0 L3_mean_L_tapetum.txt -m L_tapetum.nii.gz

MD

fslmeants -i all_MD.nii.gz -o MD_mean_cer_peduncle.txt -m cer_peduncle.nii.gz

fsimeants -i all_MD.nii.gz -o MD_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz
fsimeants -i all_MD.nii.gz -o MD_mean_ant_CC.txt -m ant_CC.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_CC.txt -m CC.nii.gz

fsimeants -i all_MD.nii.gz -o MD_mean_post_CC.txt -m post_CC.nii.gz

fsimeants -i all_MD.nii.gz -o MD_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz
fslmeants -i all_MD.nii.gz -o MD_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz
fsimeants -i all_MD.nii.gz -0 MD_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz
fslmeants -i all_MD.nii.gz -o MD_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz
fsimeants -i all_MD.nii.gz -0 MD_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz
fsimeants -i all_MD.nii.gz -0 MD_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz
fslmeants -i all_MD.nii.gz -o MD_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz

fsimeants -i all_MD.nii.gz -0 MD_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_r_alic.txt -m r_alic.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_|_alic.txt -m |_alic.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_r_plic.txt -m r_plic.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_|_plic.txt -m |_plic.nii.gz

fsimeants -i all_MD.nii.gz -o MD_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz

fsimeants -i all_MD.nii.gz -0 MD_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz

fsimeants -i all_MD.nii.gz -0 MD_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_R_ilf.txt -m R_ilf.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_L_ilf.txt -m L_ilf.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_R_unc.txt -m R_unc.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_L_unc.txt -m L_unc.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_R_cing.txt -m R_cing.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_L_cing.txt -m L_cing.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_R_hipp.txt -m R_hipp.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_L_hipp.txt -m L_hipp.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_R_slf.txt -m R_slf.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_L_slf.txt -m L_slf.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz
fslmeants -i all_MD.nii.gz -o MD_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz
fslmeants -i all_MD.nii.gz -o MD_mean_R_tapetum.txt -m R_tapetum.nii.gz

fslmeants -i all_MD.nii.gz -o MD_mean_L_tapetum.txt -m L_tapetum.nii.gz

Radial diffusivity

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_cer_peduncle.txt -m cer_peduncle.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_ant_CC.txt -m ant_CC.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_CC.txt -m CC.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_post_CC.txt -m post_CC.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz
fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz
fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz
fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz
fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_r_alic.txt -m r_alic.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_|_alic.txt -m |_alic.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_r_plic.txt -m r_plic.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_|_plic.txt -m |_plic.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz
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fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_ilf.txt -m R_ilf.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_ilf.txt -m L_ilf.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_unc.txt -m R_unc.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_unc.txt -m L_unc.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_cing.txt -m R_cing.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_cing.txt -m L_cing.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_hipp.txt -m R_hipp.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_hipp.txt -m L_hipp.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_slf.txt -m R_slf.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_slf.txt -m L_slf.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz
fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz
fsimeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_tapetum.txt -m R_tapetum.nii.gz

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_tapetum.txt -m L_tapetum.nii.gz

To Extract TBSS skeleton

fsimeants -i all_FA.nii.gz -o FA_mean_skel.txt -m all_FA_skeletonised.nii.gz
fsimeants -i all_L1.nii.gz -o L1_mean_skel.txt -m all_L1_skeletonised.nii.gz
fsimeants -i all_L2.nii.gz -o L2_mean_skel.txt -m all_L2_skeletonised.nii.gz

fsimeants -i all_L3.nii.gz -o L3_mean_skel.txt -m all_L3_skeletonised.nii.gz

fsimeants -i all_MD.nii.gz -o MD_mean_skel.txt -m all_MD_skeletonised.nii.gz

fsimeants -i all_radial_diffusivity.nii.gz -o RD_mean_skel.txt -m all_radial_diffusivity_skeletonised.nii.gz

You will now have many .txt output files. To merge them into a single file with individual

variable labels, use the following concatenate Matlab script (created by Caley Sullivan):

%A simple script to import and concatenate

workingfolder = 'E:\workingdirectory';
outfolder = 'E:\workingdirectory';
outfile = 'Output.txt';

m= 42;

files

decimal = '%.9f'

points

outpath = fullfile(outfolder, filesep,

cd (workingfolder) ;

dirListing= dir(fullfile('*.txt"));

names={dirListing(:) .name};
count= numel (names) ;
outPath= strcat (outfolder);
ALLdata = NaN (m, count) ;

for i=names;
n= find(ismember (names,i));
filename= char (i) ;

DELIM = " ';
NHEADER= 0;
data = importdata (filename, DELIM, NHEADER) ;savefile =

ALLdata(:,n)=data’';

o°

oe

o°

% Imports ALL
% Can Edit wilcards if needed
%e.g. dir(fullfile('* ant CC.txt'));

txt files

%locate your files

$location your desired output

save as
m= no.

'something.txt'
data points in .txt

data precision to 9 decimel

char (outfile)) ;

.txt files in folder

'Output.mat';
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end

fid = fopen (outpath, 'wt');

header= sprintf ('%s\t',names{:});

header (end)="";

dlmwrite (outpath,header, 'delimiter','");

dlmwrite (outpath, ALLdata, 'delimiter','\t', 'precision',decimal, '-append’)
fclose (fid) ;

cd(outfolder) ;

clear all;

Paired t-test in TBSS

Say you are comparing 12 subjects’ data before and after treatment, it might be good to try
a paired t-test instead of the normal t-test. Set this up as follows:

1. In all_FA_skeletonised you should have as first 12 subjects the first scan and as second 12
subjects the second scan

2. Use the GIm interface to set up the design and contrast: type GIm
3. Change from “timeseries design” to “higher order / non timeseries design”
4. Number of inputs 24

5. Click again on “higher order / non timeseries design” (otherwise it doesn't accept the 24;
it's a bug...)

6. Click on "Wizard"
7. Choose "two groups, paired"; "process"
8. Save as design_paired (or something similar)

9. This gives you (among other things) the files design_paired.con and design_paired.mat,
which you can use in randomise.

To test for Left vs Right symmetry, type in the following:

tbss_sym FA
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Then run the single randomize command as follows:

randomise -i all_FA_skeletonised_left_minus_right.nii.gz -o thss -m
mean_FA_symmetrised_skeleton_mask.nii.gz -1 -n 5000 --T2 -V

To test for L1 symmetry:
tbss_sym L1
then:

randomise -i all_L1_skeletonised_left_minus_right.nii.gz -o thbss -m
mean_FA_symmetrised_skeleton_mask.nii.gz -1 -n 5000 --T2 -V

Correlating or covarying in TBSS

Using the GIm module in fsl, you can create matrices to correlate DWI data with other
variables (e.g. age) or covary for a variable (e.g. severity of depression). This can be

accomplished via the FEAT module in FSL, or by typing in Glm into a terminal. The following

wiki is very useful is creating the appropriate matrix:
http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/GLM#Two-Group Difference Adjusted for Covariate
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17. DTIstudio: How to measure FA (and other statistics) of white matter tracts

Open DTIstudio (Jiang et al., 2006; Figure 30)

File > DTI Mapping (Figure 31)

Select the “Siemens, GE or Philips DICOM” option. “Continue” (Figure 32)

A page entitled, “DWI-Image Parameters” will appear: select your customized Gradient
Table file, and values will then appear in each Section of that page. Note that DTIstudio
expects the gradient table file to be in a specific format, such that 0: x,y,z is the first b-
zero, etc. That is, the first number represents the volume number, and the three
numbers after the semi-colon represent the x,y,z directions of the gradients for that
volume (Figure 33)

MAKE SURE THAT THE BOX IS UNTICKED NEXT TO “BYTE SWAP”, AND THAT “ALL
SLICES” IS SELECTED, “INFERIOR-SUPERIOR”. Make sure the b-zeros look like T2’s and
you can clearly see the CC

Check that each parameter in each Section is correct; edit if required. “OK”

A new screen will appear with 4 windows (all 3 x 2D orientations + 1 x 3D; Figure 34)
Select the DtiMap tab at the bottom left of the page

Correct for movement by using the AIR (automatic image registration) tool: select all
diffusion (i.e. not the b-zero) data then move it to the box on the right. “OK”

. Click on the “Tensor, Colour Maps etc” tab in the Calculations area (in the right hand

column; Figure 35)
DTI-Maps options windows will appear. Don’t change any of the Defaults. “OK”. A new
window may appear, “Reject Outliers?” For the moment, “Yes”, then “OK”

. Select the Fibre Tracking button on the bottom of the right-hand column
13.

You may have to flip the gradient tables in x, y, or z, depending upon your acquisition
parameters “OK” (Figure 36)

A new tab will appear in the very bottom right, “Fiber”

In the upper region of that right-hand column, Click on “ROI-Drawing Enable”
Choose an ROl shape

Apply the shape to one of the 3 quadrants on the screen (i.e. axial, sag, or coronal)
Statistics: Click on the wide rectangular “Statistics” button (Figure 39)

Note in the database (taken from the “Fiber Statistics; Select Fibers” output box):
Number of fibres

Max length (mm)

Min length (mm)

Average length (mm)

# of voxels that fibers go

Anisotropy — FA: Max, Min, Mean, Std

Anisotropy — RA: Max, Min, Mean, Std
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Figure 30. The DTlstudio software interface.
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Figure 31. Selecting “DTI Mapping”
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Figure 32. Select the type of data.
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Figure 33. The DWI Image Parameters interface.
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Figure 34. DTIstudio after the DICOMS have been imported.
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Figure 35. DTI-Map options.
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Click on the pull-down menu on the right, and select “Color Map —0” (Figure 37). This will show the RGB colours representing fibre directions.
Use the right mouse button to zoom in/out on the 3d (top left) image. Press the “+” button (right-side menu) twice to maximize the 2d images.
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Figure 37. Selecting the Color Map-0 option from the pull-down menu.
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Figure 38. An example of corpus callosum tractography as segmented from sagittal (bottom left).
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18. MedINRIA

Click on the MEDINRIA (Ayache et al., 2007) icon (Figure 40)
Select “Modules” then “DTI Track”
Select the far left icon on the top row of icons (“New .dts”; Figure 41)

A new window appears (“Diffusion weighted MRI dataset importer wizard”; Figure 42)

Click “Next”

Click “Open” and navigate to the directory where your diffusion data is located and
select the .nii file

Click “Load sequence” (Figure 43) and select the .bvec file from the same directory
(make sure you have already processed the scans via dcm2nii)

Click “Next” (Figure 44)

Flip the scans as appropriate (Figure 45)

Click “Next”, then “Finish”. Data will then be displayed (Figure 46)

Click on the “Tensor Processing” tab, and then click the colored “FA” button

A few second later the colour maps will appear. If there are any black holes in the
images, reduce the threshold and then press the FA button again (Figure 47)

Click on the “Bundle Manager” tab (Figure 48)

Click the 14" button from the left (“Track fibers”)

It will take a few minutes to track all of the fibers in the data (very computer resource
intensive)

Click “j” on the keyboard — this will engage the tracing tool

Using the left mouse button, trace around a ROI. In Figure 48 | have roughly traced
around the corpus callosum in the bottom left window

Click on the big green “tick” (validate fiber bundle)

Give the ROl a name and then select a colour after the color grid appears

Click on the ROl name (in the case below, it is called CC) and then click on the big blue
arrow (“Project all fiber bundles on to 2D views”)

Deselect the bottom left box (“Uniform/Orientation Coded Color”), and after a few

moments, all of the colour fibers will appear on the scans from each orientation (Figure

49)
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Figure 40. The MedINRIA GUI.
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Figure 41. The MedINRIA GUI after selecting New .dts

Figure 42. The data import wizard.
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Figure 43. Loading the sequence.

Figure 44. Loading the data.
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Figure 45. Flip the scan data if necessary.
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Figure 48. The bundle manager in MedINRIA.
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Figure 49. Tracking the fibers.

Click on one of the 2d buttons (top row) to show just one orientation maximized (Figure 50).
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Figure 50. Axial perspective maximized.
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19. MRtrix

MRtrix (Tournier et al., 2012) is a windows program that is easily installed (just download it
and run the .exe file). One of the great features of MRtrix is that you don’t have to make
your own bvec matrix. NOTE: there are MANY freeware packages to conduct DTl analyses,
comprehensively reviewed in Soares et al. (2013).

Open a terminal by clicking the Windows start button
type in cmd
A black terminal window will now open

P wnNPR

Navigate to your dataset (T1-weighted and diffusion data) by using the cd (change
directory command) and dir command (to list what is in the directory)
5. Type in the following:

mrconvert . T1.mif (the program will then ask you to select the directory number of the
T1-weighted dataset)

mrconvert . dwi.mif (the program will then ask you to select the directory number of the
diffusion-weighted dataset)

mrconvert T1.mif T1.nii

mrconvert dwi.mif dwi.nii

mrinfo -grad grad.txt DWI.mif

average DWIL.nii -axis 3 - | threshold - - | median3D - - | median3D - mask_DW!I.mif
dwi2tensor DWI.nii -grad grad.txt dt_DWI.mif

tensor2FA dt_DWI.mif - | mrmult - mask_DWI.mif fa_DWI.mif

tensor2vector dt_DWI.mif - | mrmult - fa_DWI.mif ev_DWI.mif

erode mask_DWI.mif -npass 3 - | mrmult fa_DWI.mif - - | threshold - -abs 0.7 sf_DWI.mif

streamtrack DT_STREAM DW.\.nii -grad grad.txt -seed mask_DWI.mif -mask mask_DWI.mif
DWI_whole_brain.tck -num 10000

Alternatively, try this:

mrconvert {DWI path} diff.mif

mrconvert {MP2RAGE INV1 path} mp2rage_inv.mif

average diff.mif -axis 3 - | threshold - - | median3D - - | median3D - mask_DWI.mif

dwi2tensor diff.mif dt_DWI.mif
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tensor2FA dt_DWI.mif - | mrmult - mask_DWI.mif fa_DWI.mif
tensor2vector dt_DWI.mif - | mrmult - fa_DWI.mif ev_DWI.mif
erode mask_DWI.mif -npass 3 - | mrmult fa_DWI.mif - - | threshold - -abs 0.7 sf_DWI.mif

streamtrack DT_STREAM diff.mif -seed mask_DW!I.mif -mask mask_DWI.mif
DWI_whole_brain.tck -num 10000

Note: if you use the eddy current and movement corrected scans (e.g. output from FSL eddy
correct) then use the —grad command (e.g. —grad eccgrad.txt) in the “dwi2tensor” command
line. Make sure to first convert your new gradient table (described on page 53 of this
Handbook) into MRtrix format by adding the b-value to end of each line of gradients and
then saving the new gradient table under a new name.txt.

For probabilistic, replace the last command with this:

estimate_response DWLI.nii -grad grad.txt sf_DWI.mif -Imax 8 response_DWI.txt

To perform deconvolution (takes time):

csdeconv DWI.nii -grad grad.txt response_DW!I.txt -Imax 8 -mask mask_DWI.mif
CSD_DWI.mif

Then:

streamtrack SD_PROB CSD_DW!I.mif -seed mask_DW!I.mif -mask mask_DW!I.mif
cst_CSD_DW.I.tck -num 10000

In a single script:
estimate_response DW\I.nii -grad grad.txt sf_DWI.mif -Imax 8 response_DWI.txt

csdeconv DWIL.nii -grad grad.txt response_DWI.txt -Imax 8 -mask mask_DWI.mif
CSD_DWI.mif

streamtrack SD_PROB CSD_DWI.mif -seed mask_DW!I.mif -mask mask_DWI.mif
cst_CSD_DWI.tck -num 10000

To open the viewer, type in:
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mrview

Maximize the screen

File = open

Open the T1-weighted file ending in .mif

Hold the CONTROL keyboard key and then use the mouse scroller to change the zoom
View - sidebar

Hold down the right mouse button and move it up and down for brightness, and left and
right for contrast

Right click in the “tracks” window, and select the tractography (called “whole_brain.tck”)
Change the value from 5.0 to 20.0 (Figure 51)

Sew Irage Help

Figure 51. Probabilistic whole-brain tractography in MRtrix.

Use the mouse scroller to navigate through the slices

Press S for sagittal, A for axial, or C for coronal

Click on “depth blend” to see the tracks in depth (i.e. 3d)

To see the scan in 3d, untick the “Lock to images axes (under the “View” pull-down
menu; Figure 52) and untick the “crop to slab” option (bottom right)
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7 F\Jerome\c_drive_sep2012\APRC_DepressionStudy)\Alfred MRI\decra_coma\control5_9oct2013_amanda\T1.mif
File View Image Help
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v Interpolate Ctri+I

v Lock to image axes
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Show Focus Ctrl-F
Reset Windowing Crl+R
Reset View ShiftCtrl+R
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Figure 52. The pull-down View menu in MRtrix.

Click the CONTROL key and the middle mouse key to reorientate the scan and play around
with the “opacity” and “line thickness”

Figure 53. Whole-brain tractography in MRtrix with altered brightness and contrast.

DRAWING ROls:

1. Load up T1 using mrview
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2. Go to View, Sidebar

3. Select ROI Analysis in drop down

4. Right click in blank box on right, click New
5. Specify filename

6. To draw, Shift + left click

7. To remove, Ctrl + Shift + left click

SPHERICAL ROIS:

e.g.

streamtrack SD_PROB CSD_DW!I.mif -seed 24.52,-25.48,9.39,5 -include 9.76,-86.94,-
2.16,10 -mask mask_DW!I.mif LGN_01Lp.tck -num 10000

spherical ROls are xco-ordinate, yco-ordinate, zco-ordinate, size
get co-ordinates from T1 in mrview, bottom left (‘position’')
Commands:

-seed

-include (only track if it goes from seed->include region)
-exclude (don't track if it goes from seed->exclude region)

tck file is a tract file, you can load this in via the sidebar

To show whole brain tractography:

1. Unclick “crop to slab” (bottom right)
2. Uncheck “lock to axes” (through the View pull-down menu)
3. Control-middle-mouse to rotate
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Example of using ROIs. In this example, using deterministic tracking of the left optic
radiations from a band of Gennari ROI, trigone ROI, and LGN ROI, and saving the
tractography as left_optic:

streamtrack DT_STREAM DW..nii -grad grad.txt -seed left_bog.mif -include left_Ign.mif —
include left_trigone.mif -mask mask_DWI.mif left_optic2.tck -num 10000

For probabilistic tractography, try this:

streamtrack SD_PROB DWI.nii -seed left_bog.mif -include left_Ilgn.mif -mask
mask_DWI.mif cst_csd.tck

Figures 54 and 55 show the result after adding in a few —exclude co-ordinates (red spheres):

Figure 54. Deterministic optic radiation tractography with exclusion spheres.
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Figure 55. Probabilistic optic radiation tractography with exclusion spheres.

If your DWI data does not align accurately with the T1-weighted data, we recommend using
FLIRT (part of the FSL package) to align the scans. That is, align the T1-weighted scan to the
DWI data (not the other way around). To achieve an even more accurate alignment, first
extract a b-zero volume from the DW!I dataset using the fslroi command:

fslroi dwi.nii.gz nodif 0 1
The output from that command will be a separate file called nodif.nii.gz
Then use FLIRT as follows:

flirt -in t1.nii -ref nodif.nii -out t1_reg.nii -omat t1_reg.mat -bins 256 -cost normmi -
searchrx -5 5 -searchry -5 5 -searchrz -5 5 -dof 6 -interp trilinear

The output from that command will be a separate file called t1_reg.nii
Then open mrview, open t1-reg.nii and the dwi.nii should align accurately to it.

To extract FA values from tractography

tracks2prob -template fa_ DWI.mif nameoftrack.tck FA_mask_track.mif
mrstats fa_DWI.mif -mask FA_mask_track.mif
To extract FA values from tractography within a ROl mask
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mrstats fa_DWI.mif -mask name_of_roi.mif

Note that there is a ‘track density’ feature in MRtrix; however, this is meant for the purpose
of validating neuroanatomy. That is, metrics derived from this feature are not clinically
interpretable. Note as well that it is suggested that you extract at least 1million tracts before
running the track density command.

To run track density:

tracks2prob DWI_whole_brain.tck -vox 0.5 tdi.mif

To run TDI on specific tracts that you have already created:
tracks2prob name_of_track_1million.tck -vox 0.5 tdi_1million.mif

Note: The examples shown above are from using MRtrix version 2.11. However, there is an
updated version of MRtrix called MRtrix3. Some of the commands are different, but it offers
better algorithms, and addition features such as orthogonal views (i.e. display coronal, axial,
and sagittal simultaneously), 3-dimensional rendering (Figure 56), and the SIFT module
(Spherical-deconvolution Informed Filtering of Tractograms; Smith et al., 2013). However, to
get the best results from SIFT, the authors advise that b-value of at least 3000 is used, and
that reverse-phase encoded bzero volumes (also known as blip-up-blip-down) are acquired
as well.

Figure 56. 3-dimensional rendering of optic radiation track density superimposed over the
subject’s T1-weighted MPRAGE scan in MRtrix3.
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20. Some useful Linux commands

e cd (change directory)

e cd..(go one directory up)

e s (list the directory)

e exit

e to force program to close, press CONTROL-C in the terminal
e mkdir (make a new directory)
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